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In this lesson you will learn how to:

e Create a New Table

e Draw a Table

e Modify Table size

e Convert Text to Table

e Insert an Excel Table

e Add Formulas

e Modify Rows & Columns

e C(reate Custom Format

e Work with Layout Tools

e Insert/Delete Rows & Columns
e Format Tables

e Complete Formulas in Word
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Print this lesson and work along side of it, practising the techniques as we go
through the lesson, by doing this you will retain more of what you will learn.

Power up Word 2007
Insert Table

To Insert a New Table we can use the Insert Tab on the Ribbon, and click on Table.
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For now let’s insert a 3x2 table, use
the Insert Table Option.

List No. Description Price
452 PC Duo Core Laptop 599.99
Draw Table

What I've typed into the table is fine, but | think that the look of the table is not
right. | can draw a Table to my choice. This may be better. This time go to the
Insert Table on the Ribbon and choose Draw Table. You will then find that Word
2007 has turned the cursor into a pen. Draw the following Table.

3 ©OBytesizeoffice.co.uk



When you have finished drawing the table you can click outside to remove the
pen. If you make a mistake just use the undo or Ctrl Z. By drawing the table we
can get a good size that we want to use, with smaller columns. But there is
another way of resizing our tables.

Modify Tables

If you move your cursor over the edge of a row or column until you see a black
vertical line with a two ended arrow through the middle, you will be able to resize
the table column. If you want to resize a row there will be a black horizontal line
with two ended arrow through the middle. Try adjusting the size of your table
columns and rows now. As you can see |I've adjusted the column size to make the
table column width smaller and the height width.

However, this is just to show you. The Table below is what you should aim for.

3

=

Handle

Notice that the table has a handle in the corner. If you click any where in your
table, you will see the handle. This also resizes your table. Click and drag the
handle now, drag it in towards the table to reduce the size and drag it out of
the table to expand the size. The four ended cross is new to Word 2007, if you
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click on it, your whole table will be selected. Which is very useful, for
formatting, which we will cover, further on in the lesson.

Convert Text to Table

List No Description Price
452 PC Duo Core Laptop 599.99

Here is the text we added to a table earlier. This time we want to convert this
text to a table. The first thing we must do is add separators. Commas are a
separator. This time add the text above and insert a comma after each part of

the text. Like so:

List No, Description, Price

452, PC Core Duo Laptop, 599.99

Once you have done that, select the text you
have just typed. On the Insert Tab click on
Table and choose from the fly-out Convert
Text to Table.

This dialogue box opens up and we
can see that we’ve got 3 columns
and 2 rows, which is what we want.
We do not want a fixed column
width so uncheck that radio and
choose AutoFit to Contents. We can
see that the Separators have been
added as Commas which is what we
used but you could also use
Paragraphs, Tabs or Other which is
a dash. Click on OK to view the
table.

Convert Text to Table |i|£_hj |
Table size
Mumber of calumns: 5 =
Mumber of rows: 2
AutaFit behavior
@ Fixed column width: | &uto =
AukoFit to conkents
AutoFit bo window
Separake text ak
Paragraphs @ Commas
Tabs Other:
(4 ] | Cancel
List No | Description Price
452 PC Core Duo Laptop | 599.99

Modify Rows & Columns

Here is our table. The columns are adjusted to the table contents but it is very
small. Click anywhere in the table until you see the handle and expand the
table. | think that this is a much better size. We can also modify the columns and
rows individually instead of the whole table. If you click in your table and look at
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the bottom of the ribbon, you will see the rulers, if you do not see the rulers,
add them now by going to the View Tab and then clicking on the rulers
checkbox. You will note that the rulers show where each of the columns end and
begin. By clicking and dragging you can adjust the size of the columns.
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There is also a ruler to the side of your screen allowing you to adjust the rows of
your table. You can also adjust the size of the rows or columns inside the table
itself. If you hover your cursor on the end of a row or column until you see a
black double ended arrow with a black line through it, you will be able to drag
the arrows until you get the size you want for your table rows or columns.

List No Description Price

452 PC Core Duo Laptop 599.99

Insert an Excel Worksheet

On the Insert Table choose insert an Excel Spreadsheet.

Plu M w CSN I Rl I = o T O P
=
- J—

M 4 » M| Sheetl/ | <] | o[ ¢

(]

The above will appear, a mini Excel Spreadsheet, you will find that your ribbon
has also changed to Excel. You can resize by clicking and dragging on a corner
of the spreadsheet or on a handle (a double ended arrow will appear to adjust)
on the middle of the row or column on the border.
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We will add some data now to this Excel Spreadsheet, complete a formula and
then adjust the table using the handles.

Let’s add: 452, 4, PC Core Duo Laptops, 599.99 each and
689, 6 PC’s Core Duo Workstations 759.00 each.

The fields for the table are: List No, Quantity, Description, Price, Total.

Add the fields and the data into your Excel Spreadsheet. Use the Tab key to
move to the next cell and return or the downward arrow on your keyboard to
get to the next row. When we click outside of the Spreadsheet, it will turn into
a regular table.

List No Quantity  Description Price Total
452 4 PC Core Duo Laptops 599
689 6 PC Core Duo Workstations 759

Resize the Description column by going to the top of the table, column C until
you see the black double ended arrow, and simply drag out the column. If you
have not worked with Excel before you will find that when you insert the PC
Core Duo Workstations, Excel will have inserted Laptops, you remove this click
before the word laptops until your cursor point turns into a black editing line,
you can then change it to Workstations. Finally resize your Excel Spreadsheet
until it fits, as above, then let go of the resizing handles and click outside the
table.

Add Formulas to Excel

Now we need to add a formula to get the totals. Enter into the total column
=B2*D2 and click enter. Do the same for the second line which is =B3*D3. Our
table should now look like this:

A, B C D E "
1 |List Mo Quantity Description Frice Total =
|2 452 4 PC Care Duo Laptops 509 23965
' 3 BEY B PC Core Duo Workstations 759 4554
14
15 | |:\[,
{4 4 » »f Sheetl <] | v

When you click outside of the Spreadsheet, you will have a regular table.
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Formatting Tables

You can format any kind of table in Word 2007, even an Excel Spreadsheet
Table. But for this exercise we will make a new table. 3x1 as shown below.

Now that we have this table it would be better with another row, click inside
your table and then right click on your mouse. Choose the Insert Option and
insert row.

CE}
[ | Paste
Inzert »
Drelete Cells..,
HEE split Cells..,
J EBorders and Shading...
|l Text Direction...
Cell Alignment 3
AutaFit »
ﬁ' Table Properties.., ¥ —
= Bullets v HH  Insert Columns to the Left
i= Mumbering » B Insert Columns to the Right
2 Hyperink.. % Insert Rowes Ahowe
G Lookup..
Synomyms , =4 Insert Rows Below
Translate » ;"-‘ Insert Cells,.,

Insert/Delete Rows & Columns

On this panel you can also insert columns and rows above. If you wanted to
delete rows, you would click on the Delete Cells option to get another panel
like the small one above but for deleting. Clicking in your table will also allow
Word 2007 Table Tools Tab to appear. See if you can see it on the top of your
ribbon. Click on the Tab to open up the Table Tools.

Table Tools

] | aapbcee | aaBbceD: AaBbCi AaBhCc . %

L | THormal | THo Spaci.. Headingl Heading2 - thange
= Styles =
= [l N P =
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You can see that there are some designs that appear to format the table. But if
you click on the small arrow along the side of the designs, another lot of
designs appear. Scroll down and you will see even more.

4 References Mailings Rewi e Wiewr Acrobat Design Layout From here you Can Choose a des'gn
Plain Tables T for your table but you must select

% the whole table first if you want the

design on the whole table.

Built-In

There are various options you can
have Word 2007 do by ticking in the
table style options, see below. Such

as ticking the box for Header Row

will allow Word 2007 to do the
header row differently. Pick a Style
you like for your Table, experiment
with it until you get a look you like.

8 Modify Table Style...

@ Clear

Ward 2007 - Tables - Microsoft Word

Hame

Insert

References

Page Layout Mailings Rewiew Acrobat Design Layout

= & shading -

- —-- = ¥ Borders v Yz pt

V| Header Rowe (¥ First Column

Total Row last Column | |- - - —

—_— o Pen Calor -
Table Styles Dravy Bord

V| Banded Rows (W) Banded Columns
Table Style Options

Custom Designs

We can also design our own table style. Select the row/s column/s or table
before you press on the fill option. You will find this option on the other side of
the Table Tools Ribbon. Choose a colour, you will see the live preview so you
can see what the finished look will be.

faut

1 Shading~| | ———— Layout Ribbon

Theme Colors

Insert a new 4x4 Table, shade it
as you prefer, adjust the

.Illllllll columns and rows. Insert the

Standard Colors following data into the table.
1 EEEEN

Mo Colar

2 Maoare Colars.,
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Quantity Description Price Total

4 Core Duo Laptops 599.00
3 Core Duo Workstations 789.00
Total

Once you have completed the table. Return to the ribbon and click on the
Layout Tab. On the Ribbon that opens up you will see there are many more
tools for tables.

m | A S Ward 2007 - Tables - Microsoft Word Table Tools

Lin
a
—/) Hame Insert Page Layout References Mailings Rewiew: e Acrobat Design Layout
lg select~ x| % E Insert Belaw Merge Cells || &[] [061em 3 B |f| HEE A= Al -7 Repeat Header Riows
2= £
] view Gridlines HH Insert Left i split Cells Srsem St HEE — =% Corwert to Text
. Delete | Insert Text Cell Sort
H Properties - sbove GiFInsertRight || = SplitTable || G AutaFit - =l =l = pirection Margins S Formula
Table Fows & Calumns (P Merge Cell Size (P Alignment Data

In the first section you can choose to view gridlines or turn them off. You can
select the whole of your table and get the properties of the table. On the
second section you can delete your table. On the third you have the options of
inserting rows and columns which is quite straightforward. On the merge
section you can select a whole row of your table, the header for instance and
merge the cells together.

You can split cells, which means you can add more sections into your table. Or
you can even split the table. Next in the cell size you can adjust the height of
your rows and columns or AutoFit which would fit according to the data.

On the Alignment Section there are new tools to Word. You can align text to
the top, middle of bottom of the cells. Then you can choose the direction of
the text. From left to right or right to left or centre. And adjust the cell

padding, the cell margins. You then have the Sort option which would sort your
table according to number or text. See the example below.
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Sort

|
Sark by You can sort to
Quantity [=] Tupe: M | © Asendng Ascending or
Idsing; |Paragraphs E| © Descending Descendmg
Hbmy This feature will do
@ Ascendi
[x] Tyoe: |Text : Dsge“ :g two sorts, one on
= I Descendin
Using: |Paragraphs [=] - . number and then
Then by one on text.
Twpe:  |Text (@) Ascending
Descending
UUsing: |Paragraphs
My list has
@ Header rowe (0 Mo header row l
Options. .. [ o4 J | Zancel |

On the next section there is a Covert text to table option and insert formula.

Formulas in Word 2007

This is what we will now do with our table, we do not have to convert it to an

Excel Spreadsheet, in Word you ca

n complete formulas too. Click on the table

in the cell where we want the formula to go. Then click on the formula option

to reveal the fly out.

Formula I.ilﬁ
Eormula;
=SUM{LEFT)

murmber Format:

Paste bookmark:

[~]

Paste Function:

Word 2007 has figured out that we
want the formula to go to the left,
but as we want to times column C
by Column A it’s wrong. So enter in
the correct formula. =A2*C2 then
press enter. Repeat for the next
row. Then total up.

=]

ok

|

Cancel ]

Quantity Description

Core Duo Laptops
Core Duo Workstations

Price Total

599.00 £2,396.00
789.00 £2,367.00
Total £4,763.00
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Formula Iilﬂ_hJ

Eorrmula:

mumber format:

=AZ*CZ

#,##0 ~
#,#40.00 o
£, A#£0.00:(£4, #0000

0%
0.00 -

When you insert your formula
ensure that you choose a number
format of how you want the
amount to be. For the last formula,
click in the Total box and Word
2007 should figure out that you
want the =SUM(ABOVE) this is
correct, change the number format
and you get the total.

That is the end of this lesson. If you practised the techniques as we went through
the lesson you will have learned how to:

Create a New Table

Draw a Table

Modify Table size

Convert Text to Table

Insert an Excel Table

Add Formulas

Modify Rows & Columns
Create Custom Format
Work with Layout Tools
Insert/Delete Rows & Columns
Format Tables

Complete Formulas in Word

Any questions please email me. admin@bytesizeoffice.co.uk
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